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Chapter 2: Your First Web Page 

Even though you can create a Web page without knowing HTML, in order to run 

experiments on the Internet, you need to know some HTML.  HTML stands for 

HyperText Markup Language, and it refers to the tags, or instructions that allow your 

browser to display pages that contain formatted text, hyperlinks, and multimedia files 

(pictures, graphics, sounds, video, etc.). This chapter will review how to make a bare-

bones Web page by typing the HTML in a text editor. It will review how to make a Web 

page without knowing HTML.  You will also learn how to download files from the Web 

and how to upload your files to a Web server, from where they can be read by anyone in 

the world. 

A. You Need to Know HTML 

 Anyone planning to do experiments on the Internet should learn some HTML.  

There is more to HTML than can be reviewed in this book, but you will learn everything 

here that you need to do the experiments in this book. 

 Although programs that create HTML or convert other documents to HTML may 

be useful, they can not do everything you need done to run an experiment.  Therefore, 

you should learn enough HTML so that you would not need them—in fact, once you 

learn HTML, you may prefer not to use such programs.  As a person doing 

experimentation on the web, you will need to know how things work to get the result you 

want. If you do not know what you are doing, you will get stuck and waste your precious 

time solving problems that a little knowledge of HTML would fix quickly.  You will 

need to know what is covered in Chapters 2-4.  You can learn the material on HTML in 

these chapters in about 4 hours, which will be a very worthwhile investment. 
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B. A Simple Web Page 

 Here is how to create a simple document in HTML that can be displayed by a 

Web browser.  Start a simple text editor such as NotePad, SimpleText, or BBEdit Lite; 

these programs all allow you to save files as text only.  To make a Web page, you should 

save as Text (ASCII) only, and give the file an extension of .htm or .html.  These 

extensions help browsers and other applications recognize that this text file contains 

HTML. 

Consider the case of a student planning to do her senior thesis the topic of visual 

illusions.  She might advertise her interest and request help from the Internet community 

by means of a Web page such as in Figure 2.1.  Type the contents of Figure 2.1 into your 

text editor exactly as displayed.  To avoid confusion, you should use a text editor (e.g., 

NotePad, SimpleText) rather than a word processor (e.g., MS Word) for this example. 

     Insert Figure 2.1 about here 
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Figure 2.1.  The composition of a simple Web page. 

<HTML> 

<HEAD> 

<TITLE>Visual Illusions on the WWW</TITLE> 

</HEAD> 

<BODY> 

<PRE> 

 

Hi. I'm a junior in psychology at Anytown College. 

I'm planning to do a senior research project  

next year on visual illusions, and I hope to  

put my experiment on the World Wide Web.   

I would be grateful for your  

assistance. 

 

If you are conducting such research, or if you know of  

others doing such research, please write me:  

 

Ms. Ann E. Student  

100 College Lane, Box 100  

Anytown, State 10000-100  

 

Thank you for your help. 

</PRE> 

</BODY> 
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 This document, or "page" has HTML commands, or tags, which are placed in 

angle brackets <>. These tags instruct the browser how to display the page.   

Most commands in HTML have a beginning tag and an ending tag. Ending tags 

contain a slash (/).  For example <HTML> says that what follows is HTML, and the tag 

</HTML> designates the end of the HTML document. Everything in between is the HTML 

"page."  

Each HTML page has a HEAD and a BODY. The <HEAD> and </HEAD> tags 

designate the "head" of the document, which contains the title that will be displayed at 

the top of the window.  You will learn other things that can go in the HEAD later. 

<TITLE> This is the title </TITLE> contains the title displayed at the top of 

the browser’s window. 

<BODY> text </BODY> contains the body of text for the document.   

The <PRE> tag indicates to the browser that the next text is preformatted. 

Preformatted text is displayed in an equal spaced font.  In an equal, or mono-spaced font, 

each character or number has the same size.  If your document contains line returns and 

tabs, these will also be preserved in preformatted text. </PRE> turns off the pre-formatting.  

Figure 2.2 shows how the page will look when typed into NotePad, a text editor 

for the PC.  When you save, be careful to click the Save As Type pull down list in the 

Save dialog box, as shown in Figure 2.3, and choose All Files; otherwise, NotePad adds 

the extension of .txt.  When you try to open HTML files in NotePad, you should also 

select All files, or NotePad will only display files with the .txt extension. 

  Insert Figures 2.2 and 2.3 about here.
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Figure 2.2.  Appearance of Example 1 in NotePad.  This file is available as Ch2_ex1.htm 

on the CD that accompanies the book.  On a Macintosh computer, you could use 

SimpleText or BBEdit Lite as your text editor. 
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Figure 2.3.  Save As dialog in NotePad.  Be sure to select in Save as type: All files, and 

give the file an extension of .htm or .html. 
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Type a file with the above information in it (or open the example, Ch2_ex1.htm, 

from the CD that accompanies this book in your text editor), and save it on your hard 

drive.  Save the file with the name, test.htm.  You paste in some other formatted text to 

replace the body, such as your vita or résumé (you can change the title to Vita Of Your 

Name), which you might save with the filename, vita.htm.  To see what your file will 

look like on the web, start your browser (e.g., Netscape or Internet Explorer), and choose 

Open File from the File Menu.   

When you open the file in the browser, it should display as in Figure 2.4 (which 

illustrates the display in Netscape Communicator 4.05 for PC).  You can also open this 

example from the CD that accompanies your book, which saves you the labor of typing 

it.  Open the file, examples.htm, in your browser, and click the link to Chapter 2 Example 

1.) 

 Insert Figure 2.4 about here 

 If you made a an error, failing to put in a closing tag, using parentheses 

(parentheses) instead of angle brackets <brackets>, misspelling the commands in a tag, or 

something else, then your page may not display correctly.  When there is an error, 

different browsers may display your page differently, so it is important to correct any 

error you catch. Even if everything looks ok on your own browser, it may not display 

correctly for somebody using Explorer instead of Netscape or on a PC instead of a Mac.   

 HTML is not case sensitive.  That means that you can use <HTML> or <html>, 

and it will work the same either way.  However, JavaScript is case sensitive, so be careful 

when you get to Chapter 17.  In this book, HTML tags will be written in all caps, to make 

them easier to spot, but they don't have to be written that way. 
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Figure 2.4.  This figure shows how the sample file, Ch2_ex1.htm, looks when 

displayed by Netscape. 
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When you are content that your file displays correctly on your browser and there 

are no errors, you can upload the file to your server by means of an FTP program, as will 

be described later. 

C. Creating a Web Page without Knowing HTML 

If you can use a modern word-processor, such as Microsoft Word or WordPerfect, 

then you can create a document in HTML.  You can create a document in Word or 

WordPerfect, and then save it as HTML.  You can also create HTML files using 

programs such as Netscape Communicator (Composer), PowerPoint, and many others. 

Suppose you want to place a paper you have just written on the Web.  Your report 

might be an MS Word document that contains graphic images, equations, charts, tables, 

and pictures.  Load it into your word processor; next, select Save as HTML... from the 

File menu.  

The Save As HTML... dialog allows you to give the file a name. When you Save 

as HTML, you should save your file under a new name, to make sure that you do not 

erase your original file and lose information when you save as HTML.  You should give 

it a filename with an extension of .htm or .html.  This extension will help various 

programs recognize the file as a file that contains HTML.  Depending on your program 

and system, the extension may be added automatically for you.  You should save into an 

empty folder, so that you can keep track of all of the separate files created.  When you 

save, MS Word creates several files that contain the text and graphics, and it creates the 

HTML to link these files together.  If your document contains line drawings or pictures, 

then these will be saved as separate files along with the file of formatted text. 
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You can display the HTML files you create this way in your browser.  You can 

also open the HTML file in the application that created it.  For example, you can open 

your HTML files in MS Word.  In MS Word, you can view the HTML source from the 

View menu by selecting HTML Source from the View menu.   

Browsers also allow you to view the HTML code for any file that is displayed.  In 

Netscape, for example, you select Page Source from the View menu; in Explorer, you 

select Source from the View menu.   

This means that you can view (and save) the HTML of any page on the web.  You 

can save the HTML of another person's page and use it to learn. You can also save 

graphic images and pictures from your browser, too.  To save a graphic on a PC, point to 

it and right-click.  A menu will appear giving you the option to copy or save the image.  

On a Mac, click and hold down the key, and the same menu will appear.  When you save 

another person's HTML code or images, you should realize that you have copied another 

person's work and you should obtain permission from the author and copyright holder 

before you use it in any way that might violate copyright laws or ethics.  More will be 

said on this topic in the chapter on ethics. 

Once you have created an HTML page with a word processor, view the source 

file, and you will see each of the tags that were explained in this chapter, and some others 

besides.  You will learn about those other tags in later chapters. 

To place your paper on the Web so that others can read it from anywhere in the 

world, you must now upload to your files to a public folder on a Web server.  A Web 

“server” is a computer connected to the Internet that delivers (“serves”) files via the 

Web's protocol, known as HTTP for HyperText Transfer Protocol.  The term “upload” 
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means that you send copies of the files you created (when you saved as HTML) from 

your personal computer to your Web server.  The next sections will teach you how use 

FTP (File Transfer Protocol) programs for uploading and downloading programs to and 

from a Web server. 

D. Uploading and Downloading to the Web Server 

To send files to a server (upload) and to retrieve files from a server (download), you 

need a program that can send and receive files.  Programs based on FTP (file transfer 

protocol) such as Fetch for the Macintosh and WS FTP or CuteFTP for Windows can do this 

task.  Browsers can also transfer files by FTP, but they do not have all of the features of a 

dedicated FTP program.   

E. Using Netscape to FTP 

In your browser, type FTP:// instead of http:// in the address box. To connect to 

the psych.fullerton.edu site via Navigator or Explorer, type the following line: 

ftp://guest:guest99@psych.fullerton.edu 

Note three things in the above line.  First, it is ftp:// instead of http://.  Second, the format 

of the line is userid:password@server.address.  Third, this line includes an @, as is seen 

in email addresses, but not Web addresses.  The userid in this case is guest, and the 

password is guest99.  This password allows you to download, but not to upload.  

Figure 2.5 shows the appearance of an FTP session in Netscape. You will see a 

list of files that can be downloaded.  By clicking on the file, you may or may not be able 

to view the file—you may see only a blank screen.  Whether you can view it or not, you 

should next select Save As from the File menu, and save the file in a location that you 

will find handy later.  (On a Mac, clicking a file may automatically download a copy of 
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the file to the desktop.  On a PC, people often “lose” files that they save in these 

situations, so if you use a PC, you should make a note of the directory folders in which 

you saved any file that you download.  If you clicked Save, and you don’t know where it 

went, make a note of the file name immediately, and use your Find File utility, which 

you can reach from the Start button.  If you forget the filename too, you can try 

searching by date with Find File. 

 Insert Figure 2.5 about here. 

 Netscape also allows you to upload files (if you have permission), by selecting 

Upload file from the File menu.  Internet Explorer also supports file transfers by FTP in 

much the same way. 
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Figure 2.5.  Using FTP in Netscape.  By clicking on a file, the file can be downloaded. 
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F. Downloading Software from the Web 

Although browsers can handle file transfers by FTP, it is more convenient to use 

dedicated programs when you have many files to manage.  If you do not already have an 

FTP program, there are many that you can download for free.  In fact, there are many 

programs for all kinds of purposes that you can find free on the Web.  To search for 

programs, you can use your browser with a search engine to find vendors and free 

software sites maintained by clubs and users groups.   

A site that supports downloading of freeware, shareware, and commercial 

software has the URL 

 http://www.download.com 

Use your browser to get to the site, then check to make sure that you are in the 

site for PC (if you have a PC) or Mac (if you have a Mac).  If you are at the wrong site, 

scroll down the page and click the link to send you to the appropriate site for your 

computer.   

To search for FTP programs, type ftp in the search box, and click the search 

button.  A number of programs will be listed.  You can read brief descriptions of the 

programs, including information on when the programs were posted and how many 

people have downloaded those programs.  When you have selected a program, you can 

click the link and follow directions for downloading and installing your software.  

Figures 2.6 and 2.7 show the screens at www.download.com that illustrate the case for 

the PC.    

      Insert Figures 2.6 and 2.7 about here. 
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Figure 2.6. To download software from www.download.com, use your browser to 

go to that location, then type the software you are looking for in the box.  Here, ftp has 

been typed in the search box.  This display shows Download.com for PC.  For Macintosh 

software, click the link at the lower left of this page (not shown). 
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Figure 2.7.  There are several pages of FTP programs to choose from.  Popular 

FTP programs for PC are CuteFTP and WS FTP LE, both of which are free to 

noncommercial, educational users.  A popular FTP program for Macintosh is Fetch, also 

available from www.download.com. Before you download Fetch, check if you already 

have it on your hard drive; for years, new Macs came with Fetch installed. 
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G. Using an FTP Program with Your Local Server 

 O.K., now you have FTP software.  You will need an account and password for 

your local server.  Next, you will upload your file to the appropriate location.  When you 

have uploaded your HTML file (e.g., from Chapter 1) to an appropriate folder on a Web 

site server (a computer that is connected to the Internet and has Web site software 

running on it), anyone in the world can read your document if they know the URL.   

If you are at an educational institution, you should become acquainted with the 

person who runs your department's or your unit's server.  That person can give you a 

password and an account name (folder name) for your space on the server.  That person 

may also be able to help you with programs to upload and download to and from the 

server. The person who runs your server can also tell you the URL that will take your 

browser to your territory on the Web (your directory or folder).  The person who runs the 

server will also ask you about security, which refers to the issues of who gets to read the 

files in your folder, and who gets to write to them.  You want to be able to write to them 

by password only.  For the experiments in this book, you want your folder to be readable 

to everyone.  When your folder has been established with read access to everyone and 

write access to you by password only, you will upload your files to that folder. 

If you have a commercial Internet service provider, you should check the 

materials they sent you about uploading and downloading files. Your commercial 

provider may require you to use special programs for Web access and for sending and 

receiving files.  The price of your service may depend on how much material you plan to 

upload to the server. 
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 Suppose you do not yet have an account and a password on your server.  

(Eventually, you will need one to carry out independent research on the Internet).  In the 

meantime, however, you can practice using your ftp software with the following 

download-only ftp site that is available to you.   

The ftp software needs to know the name of the host computer to which you wish 

to connect, it needs to know your user id (sometimes known as an account name), your 

password, and it may also request the directory to which you wish to connect.  To 

connect to the psych.fullerton.edu server, enter the following information into your ftp 

program in the "connect" or "establish new connection" dialog box: 

Host: psych.fullerton.edu 

User ID: guest 

Password: guest99 

Directory: (if this is listed, leave it blank, if account number is requested, either leave it 

blank or insert your user ID).   

 If the host type is requested, set it to Automatic Detect if you can.  If you know 

what type of server you have, you can enter that in the appropriate space.  The 

psych.fullerton.edu server is a Windows NT server. 

When you have entered this information to your program, you will click the 

button that says "OK" or "Connect," and the program will show you a list of files 

available for you to download.  This step is illustrated for WS FTP LE in Figure 2.8. 

 Insert Figure 2.8 about here. 
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Figure 2.8. Using WS FTP (Limited Edition).   Connecting to a server by FTP 

requires that you enter the host name, the user id, and password.   Here the host name is 

psych.fullerton.edu, the user’s id is guest, and the password (hidden) is guest99.  Clicking 

OK will establish the connection.  WS FTP will also save the settings for future sessions. 
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Remember: For this site, you cannot upload files to psych.fullerton.edu, and if 

you try, you will get a message telling you that you can not do that.  You can download 

files, however, and there are several files related to this book at that site.  The files 

available to download from this site include examples of experiments and data files 

containing data from various experiments. 

 FTP programs usually have a button to click or box to check that indicates the 

type of file you are transferring.  Some have a button for "automatic," which is supposed 

to figure out what type of file it is by its extension or from information within the file 

itself.  When you are working with HTML, you should send and receive the files as text 

by selecting text (or ASCII) for the type of file to be transferred.  When sending files 

containing images, send as binary (sometimes called "raw data").  You can also use 

binary to send and receive ASCII.  Do not upload files in compressed formats, or formats 

like MacBinary that do not transfer to all users.  This step is illustrated in Figure 2.9.  

 Insert Figure 2.9 about here.    
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Figure 2.9. Downloading a file by WS FTP (Limited Edition).  The local system’s 

directory can be changed with the ChgDir key, by double clicking a folder to open a 

visible folder, or by clicking the up arrow to go to the next higher level.  To transfer a 

file, click on it (which highlights it), and click the arrow to send the file.  Be very careful 

which arrow you click!  Note in the picture that the ASCII button is clicked, and also that 

the Auto box is checked.  This file, exp2a.htm, is being sent from the server to a folder on 

the local computer’s C drive.  The View key opens the selected (highlighted) file in 

NotePad. 
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 Figures 2.8 and 2.9 illustrate the screens on the PC for WS FTP LE (Limited 

edition).  In Figure 2.9, the left side shows the local computer, and the right side shows 

the remote (server) computer.  After selecting a file, pressing the arrow pointing left 

sends a file from the server to the local computer.  If you have uploading privileges, 

pressing the right-pointing arrow would send the selected files from your local computer 

to the server.  Be very careful with any FTP program to send files the right direction!  

Especially when you want to make changes to a file that already exists, you must be 

careful to upload the new version of the file, or you may accidentally replace the new 

version on your local computer with the old version.  It happens fast without an "are you 

sure?" warning.  Be careful not to double click on a file name, as that will send it.  One 

idea is to keep copies of files in working folders, then copy them to a special folder that 

will be used for file transfer.  That way, you will have your originals in their original 

folders even if you accidentally download when you meant to upload.  Be careful. 

Once you have uploaded your file to a public folder on the Web, anyone can enter 

its URL in their browser and read the document.  Anyone in the world can now read your 

file if they know the URL.  In later chapters, you will learn how to publicize your site to 

help people find it. 
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H. Summary 

In this chapter, you learned that you can create HTML documents either by using 

an application such as MS Word, or by typing HTML in a text editor (e.g., NotePad), and 

saving as text with an extension of .htm or .html.  You should now understand the HTML 

tags in Table 2.1, which you should be able to use to create a simple page. 

 You should also understand how to upload and download files to and from your 

server.  If you know the terms in Table 2.2, and if you can do the exercises, then you are 

prepared to go on to the next chapter.   

 
Table 2.1. Summary of HTML tags in Chapter 2. 

HTML Tag What it does  

<HTML></HTML> Signals HTML start and ending.  

<HEAD></HEAD> Signals the beginning and ending of the head of an 

HTML page 

 

<TITLE></TITLE> Place the title to be displayed between these tags.  

<BODY></BODY> The body of the HTML page is placed between these 

tags. 

 

<PRE></PRE> Preformatted text.  Tabs, returns, etc. will be 

preserved and displayed.  Each character will have the 

same width. 
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Table 2.2 Terms used in File Transfer 
 
File Transfer Terms Definitions 

FTP File Transfer Protocol 

Upload Send file from local computer to server 

Download Receive file on local computer from server 

 

I. Exercises 

1. After you have viewed the first example in your browser, try removing the <PRE> 

and </PRE> tags from the document.  Save the new version, and reload it in the 

browser.  How does the document look now?  What has happened to spacing, tabs, 

and line returns? 

2. Try changing the HTML tags from all caps to lower case.  Does the file still display 

the same way?  It should look the same (unless you made a typo). 

3. Use a word processor to create a page with formatting such as bold, italics, different 

fonts, etc.  Use Save As HTML to create a page.  Load this page into a browser.  Does 

the page look the same in your browser as it does in your word processor?  Now load 

it in your text editor and examine the many interesting tags.  Find the ones of Table 

2.1. 

4. Use a text editor such as SimpleText or NotePad to create a Web page using the tags 

in Figure 2.2 and Table 2.1.  For example, take your résumé or vita, and convert it to 

a Web page by adding a title and using the Pre-formatted text tags.  Load this page in 

your browser.  How does the page look?  You can edit the page and save your 



Chapter 2 03/28/16 25 of 25 

changes, then use "Reload"("Refresh" in Internet Explorer) to bring your browser up 

to date.  How does it look in the browser? 

5. Use your ftp program to download the file, exp2a.htm from the psych.fullerton.edu 

server.  Open this file in your browser.  Also try opening it with a text editor such as 

SimpleText or NotePad.  You will see some HTML tags that will look familiar, and 

you will also see some tags that you may not recognize.  You will learn all of them by 

Chapter 5.  

6. Use your browser or ftp program to upload the files you created to your local Web 

server.  Then use your browser to display the files from the URL of your Web pages.  

To do this exercise, you will need a local Web server with a username and password. 


